
DUMPStat 2.1.8 Release Notes
These release notes cover all the changes made to DUMPStat since 
version 2.1.1; as well as documentation errors and omissions from the 2.1 
User & Statistical Guides.

Changes since version 2.1.1

April 25, 2003 Release

Outlier detection in Up 
vs. Down Prediction 
Limits corrected

The January 2003 change to outlier detection in Up vs. Down Prediction 
Limits introduced an error such that samples for the last well in the list 
of upgradient wells were not compared to the median value. Since only 
Dixon's test was being used to determine outliers, the last well could have 
samples declared as outliers without them being greater than 10 times the 
median value which was inconsistent with the other analyses. This has 
been corrected.

April 17, 2003 Release

Manual reporting 
limits corrected in 
sublist prediction 
limits

Manual reporting limits were not implemented correctly in Intra-Well 
Sublist Prediction Limits such that nondetects were ignored in the 
calculation of background limits. This did not affect the nonsublist 
version nor were any other analyses affected. The error was introduced 
in the January update.

Site locking improved Minor enhancements were made to the new site lock disabling feature.

Inaccessible site 
directories no longer 
permanently alter a 
site’s status

Inaccessible archival directories no longer cause a site to be permanently 
set to "read only" status. Previously, if a network drive were unavailable 
when DUMPStat was started a site could be put in a "read only" state 
such that the site could not be saved. Now the site is set to "read only" 
only during the time when the drive is not accessible and access is reset 
to "read write" when the program starts with the archival directory 
available to the computer.
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January 2003 Release

Outlier testing 
improved

The outlier test was altered to eliminate round-off error caused by 
internal processing. For a value to be considered an outlier it must be 
classified as such by Dixon's test and be more than either 3 or 10 times 
the median value depending on the analysis being performed. Prior to 
this correction values that were exactly 3 (or 10) times the median value 
may have been considered outliers. Now values must be strictly greater 
than 3 (or 10) times the median value in addition to Dixon's test to be 
classified as outliers.

Manual reporting 
limits now treated 
differently

When manual reporting limits are enabled, they are still used in the 
calculations but are no longer plotted on the graphs. Instead, the 
nondetect samples are plotted at their original merged values, and the 
manual reporting limit for that constituent is instead indicated on the 
graph by a small diamond. If you are doing confidence limits, surface 
water or air analyses, the manual reporting limit is divided by two. In 
cases where manual reporting limits are not enabled, or where they are 
but the constituent doesn't have one, the median [lab] reporting limit, or 
half the limit, is used.

Grid display option on 
Comparison to 
Background Power 
Charts

There is a new display option for the statistical power charts to overlay 
five dotted lines on the graph. Two vertical lines appear at 3 and 4 SDs 
(standard deviations) along the horizontal axis, and run from the top to 
the bottom of the area bounded by the axes. Three horizontal lines 
appear at 5%, 50%, and 80% likelihood on the vertical axis. The lines 
provide a visual reference for judging the position and steepness of the 
power curve, and are displayed either all together or not at all. They will 
also be printed if you have them turned on.

New Site Locking 
options

DUMPStat now allows more flexibility in site locking. You may turn off 
site locking altogether (if you are the only one using DUMPStat, for 
example), and you may also choose when to have DUMPStat write to the 
archival site directory.

Time series trend test 
now screens for 
automatic outliers

Previously, DUMPStat observed only manual outliers while testing for 
trends in Time Series (if manual outliers were enabled). Now, DUMPStat 
screens for automatic outliers too, and then performs the trend test, if 
you are identifying historical trends.

New file type 
displayed in Select 
File for Merge Data

When you select a data file to merge, text files are now listed as .PRN as 
well as .TXT. in the ‘List Files of Type’ box. The recognized file types list 
includes .rec (leftover records), .csv, and .dat, and all files.

DUMPStat and 
Explorer now work 
more smoothly 
together

When DUMPStat and Explorer are using the same site, there used to be 
conflicts when each program was attempting to access the database. 
There is now a higher degree of compatibility between the two programs, 
and there will be no failures if the database is being accessed 
simultaneously.
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Warning to save 
changes now less 
sensitive

For setting manual reporting limits and standards (in Select for 
Assessment), if there was at least one item that did not have units (like 
pH), you were asked whether to save your changes if you simply 
cancelled out of the dialog without changing anything. Now, there is no 
enquiring message box if you cancel out of the window with no changes.

Logarithmic scaling 
problem fixed

In the Graph Viewer, log scaling used to work incorrectly in some cases, 
such that points ended up well above or below the main plotting area. 
This has now been fixed.

June 2002 Release

Printer switches now 
take effect 
immediately in most 
output viewers

Previously, if you changed the printer in either DUMPStat or any of the 
viewers, it was necessary to shut down the program and restart it for the 
change to take effect. Now, the Graph, Worksheet, and Power Chart 
viewers allow you to make a printer switch and see the change 
immediately, without restarting. However, it is usually still necessary to 
restart DUMPStat or the Table Viewer if you have changed the printer in 
either one of these programs.

Half year display 
corrected

When the data for a graph spans a very short period, the default time 
display in the Graph Viewer is a half year. This display used to range from 
January to June. It has now been corrected to read January - July.

Improved small text 
display

Small text on analysis output has been clarified and is now easier to read. 

March 2002 Release

Two-sided limits 
corrected

In Sublist Control Charts and Prediction Limits, two-sided limits for all 
constituents after pH have been eliminated and the correct single limits 
are now being displayed.

October 2001 Release

Viewers now more 
robust 

DUMPStat communicates more smoothly with the viewer applications 
now, eliminating occasional error messages generated when statistical 
settings were changed with old output still open. 
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September 2001 Release

Statistical Options 
saved with zones

Zone files now save all settings on the Statistical Options screen. This 
allows you to work even more quickly, with fewer settings to change 
when loading new zones. 

More Time Windows 
options saved with 
zones

All settings chosen in the Set Time Windows dialog are now saved with 
zones. This includes the option to include the most recent data for Up 
vs. Down analyses, and to ignore all data beyond a specified month.

The setting on the Miscellaneous tab of Settings > Program Options for 
“Load Zone Overwrites Background Time Windows” only applies to 
settings for individual wells. It does not apply to these ‘global’ Time 
Window settings: “Automatically include the most recent data” and 
“Ignore all data sampled after the month x.” These global settings will 
always be included with the zones, regardless of what you have chosen 
on Settings > Program Options > Miscellaneous.

Zones now multi-
version compatible

Zones can now be successfully transferred between different versions of 
DUMPStat.

Analytical Data 
Summary tables now 
accept numbering 
changes

Analytical Data Summary tables can now be custom numbered. You may 
have consecutive numbering, or set all ADS tables to have the same 
number.

Longer tables 
numbers allowed

All tables can now be custom numbered with numbers up to 3 digits 
long. If necessary, you may also use negative numbers for all except 
Analytical Data Summary tables.

Up vs. Down Table 6 
now editable

Table 6 in Up vs. Down Prediction Limits now accepts changes in title 
or table number.

New default merge file 
format 

There is a new default file extension (*.txt) displayed in the Select Sample 
Data File to Import window (when merging new data files).

Improved program/
viewer communication

DUMPStat communicates smoothly with the viewer applications now, 
eliminating occasional DDE error messages generated when statistical 
options were changed while viewer windows were open. 

Merge Data window no 
longer fails with 
illegally grouped data

Merge Data window is now more robust, with no more failures due to 
illegally grouped numbers.

April 2001 Release

Correct page 
numbering

Instances of page numbering starting at page 2 have been eliminated.
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March 2001 Release

Prediction Limit Alpha DUMPStat now allows you to choose two alpha value options. The alpha 
value represents the false positive rate or Type 1 error rate, and is used to 
calculate the prediction limits in the Intra-Well (and Sublist) Prediction 
Limits analyses. You may choose “Limit to 0.01” or “Use calculated 
value.” The former is the default setting for this option.

Outliers in Up vs. 
Down Prediction 
Limits corrected

Previously, there was an error in the Up vs. Down Prediction Limits 
statistical module that, in particular circumstances, caused DUMPStat to 
wrongly designate outliers and miscalculate the detection frequency. 
Outliers & detection frequencies for this analysis are now accurately 
identified in all cases.

Fix Horizontal Axis 
works with empty 
graphs

The Fix Horizontal Axis function has been fixed to work with graphs 
that don't have any data points. 

Clearer message for 
Power Charts

Statistical Power Charts that couldn't be computed are flagged with a 
more informative message than previously. 

Better log scaling with 
prediction limits

Log scaling has been improved so that lower prediction limits are now 
drawn at 0. 

Printing without 
output handles better 

Print command is handled more gracefully now if there are no graphs to 
view. 

No more ‘installation 
out of sync’ errors

DUMPStat now handles unexpected Windows shutdowns more 
gracefully and will no longer display an “Installation out of sync” error 
message upon the program startup. 

‘Ignore Data After’ no 
longer causes 
analysis failure

For Intra-Well (& Sublist) Control Charts, Time Series, Intra-Well (& 
Sublist) Prediction Limits, and Confidence Limits, analyses will not fail if 
the “Ignore Data After” Time Windows command has been set to 
exclude all data from the analysis.

High y-intercepts now 
display correctly on 
Power Charts

Power chart curves now display correctly when the y-intercept is 90 or 
higher.
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2.1 Documentation Omissions & Corrections
The following documentation omissions contain references to the 
appropriate page numbers in the printed version of the User’s Guide. 
The User’s Guide PDF has been corrected.

User Name
Program Options>Names, 
2.1 User’s Guide pg. 65

If any conflicts occur between people wishing to use the same site(s), 
DUMPStat will notify each user as necessary and describe what actions 
they may take. In order to provide such notification, DUMPStat must be 
able to identify who is issuing the site commands. That is, DUMPStat 
needs to know who is working at each installation of the software.

Enter your user name on the Names card of Program Options from the 
Settings Menu. You can reset it as often as you wish. If no name is 
entered and DUMPStat needs to know who you are, you will be 
prompted to enter one.

Margins
Page Layout>Margins, 2.1 
User’s Guide pg. 79

Selecting Page Layout for margins allows you to set the amount of white 
space that will border your output on printed pages. Simply enter the 
number (in inches) that you wish to have at the top, bottom, left and right 
sides of either a portrait or landscape page.
The headers, including the site name, client name, and page number are 
not drawn in the margin area. Thus, if you choose a 1" margin, you are 
guaranteed 1" of white space around the outside of the paper.

Statistical notes
Select Pairs for Surface 
Water and Air Monitoring, 
2.1 User’s Guide pages 164 
and 167.

There is a correction to the statistical notes on pages 164 and 167 of 
Chapter 9, The Sample Points Menu, in the printed 2.1 User’s Guide:

Only upstream/downstream or upwind/downwind paired samples 
taken on the same day are displayed on the graphs, but all data (paired or 
not) from the start of the time window are used for the trend test.

Sample point names 
with ‘&’
Illegal Characters, 2.1 
User’s Guide, pg. 268.

Any constituent names that contain ‘&’ will be changed to contain ‘+’ 
when the data records are merged into the DUMPStat database. This 
change does not occur for sample points containing ‘&’. 

Margins may range from 0.5 
to 3 inches wide.
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Outstanding Issues
Large records cause 
analytical data 
summary error 
message

An error message of “Record is too large” may occur during the 
analytical data summary analysis. Although MS Access has a specific limit 
of 255 on the number of columns, it appears there is also a limitation on 
the number of rows as well. At this time, we have not determined what 
the maximum allowable size is for the analytical data summary.

Graph viewer Y-axis 
incorrectly labels 
small values as zero

At present the program does not allow label sizes of less than 0.0001; 
instead they are rounded down to zero. Depending on the units used, this 
limitation may results in ‘0’ labels.

VOC list shows same-
day entries separately

If there are two samples on the same day, they are listed as distinct entries 
in the historical VOC detections list. In all other analyses, multiple 
matches are averaged and listed as a single entry.

Wide worksheet 
columns can overlap

Lengthy expressions appearing in the equation column of a worksheet 
can obscure the first few letters of an item in the description column. 
However, this will not likely be a problem with printed output.

Windows NT reverses 
output orientation to 
PDFWriter

If you print any viewer output using PDFWriter as your printer, 
WIndows NT will cause your chosen orientation to be switched. If you 
need to make a PDF document, simply set the orientation in DUMPStat 
to be the opposite of the one you really want.

Windows decimal 
separator must be 
period (.) for viewers 
to work

If you have set your Windows’ decimal separator as a comma (as is done 
for the internationalization settings in Europe), DUMPStat will be unable 
to display the viewers correctly. For this reason, please ensure that the 
decimal is a period.

Time in edit log 
incorrect with 
Windows 2000 24-hr 
clock 

If you use the 24-hour clock time display option in Windows 2000, your 
database edits will be entered in the Edit Log as being 12.5 or more hours 
later than the time the edits were actually performed.

Table Viewer page 
count may be 
inaccurate

There are programmatic discrepancies with the interpretation of font size 
between the table viewer and the DUMPStat printing routines. This may 
occasionally cause a small inaccuracy with page count.

E-mail registration 
requests sometimes 
fail

To register DUMPStat for full functionality, the Register Features dialog 
automatically generates an e-mail message for Discerning Systems which 
contains the required codes for authorization. However, the correct 
information may not always be inserted in the e-mail message. When you 
review the message before sending, please ensure that the query string, 
user ID, and two status strings are present. If they are not:
◗ Attach DSIREQ.TXT to the email. This can be found in your 

DUMPStat program directory (usually C:\DUMPSTAT).
◗ Click on the Prepare a Fax button in Register Features, OR

◗ Phone Discerning Systems toll-free at 1-877-374-7744 to register.
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